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Scope of Manual

This Insturction Manual provides instructions for
operation, maintenance, adjustment and troubleshooting of
VRG Controls RCVC - Red Circle Valve Controller.

Configuration Methods
1. Navigation Wheel
2. Setup Application vis USB Setup Cable

Navigation Wheel USB Setup Cable

Features

* Reverse Valve Action: Can easily switch between Direct
Acting and Reverse Acting.

*  Three states of Edit Fail Modes: Lock Last, Fail Open
and Fail Close

*  Three modes of Lockup Mode: Lock up Open, Lock up
Close or both.

»  Split Range Configuration: Can set to any Range

* Dead Band Calibration for Open and Close: can be inde-
pendently set.

* Pulse Control: can adjust the Range when the Pulse is
activated

* Pulse Zone Timers: Adjust the length and duration of
pulse

* Fixed Command: Output for Pilot Override Applications

* Enable Anti-Surge Control: Set the Range for when the
Surge will Activate.

*  Various Alarm Functions dependent on Failure State.

e Zero Out Solenoid Count: Can reset for new Solenoids
both Open and Close Count.

*  Remote Command and Remote Override using 24VDC.

Technical Assistance

Should you have any questions, you may
contact your local VRG Controls sales representative or

VRG Controls technical assistance at:

VRG Controls

Attn: 1199 Flex Court
Lake Zurich, IL 60047
Toll-Free: 844-FLOW-VRG (844-356-9874)
Tel: +1847-778-6740
e-mail:  sales@vrgcontrols.com
websight:  www.vrgcontrols.com

To facilitate requests for technical assistance, please have
the following information immediately available:
e Job number or serial number
* Fail states or messages
*  Command signal Configuration
4ma to open or 20ma to open
* Interaction method

(navigation wheel or computer software)

Warning

Do NOT use a multimeter to check the feedback readings.
Do NOT use a multimeter to check feedback Retransmission
Signal. By connecting the negative lead to the feedback
(Al1) and the positive lead to 24 VDC, you will short out the
board. This will require a replacement board to fix the issue.

Warning

The new RCVC app is not compatible with the old setup
files. To use the new RCVC you will need to load a new
setup file into the RCVC. The new setup files are compati-
ble with the old VRG Programming Application. Any RCVC
purchased after 3/1/2021 will have the new setup file already
installed in the RCVC.
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Table 1.0 RCVC Specifications

Power Supply

Power Supply 19-30 VDC
RCVC Module Current 50mA max
RCVC Total Assembly Rating 2A max

Onboard Fuse

Limitron: FNQ-R-2 600VAC IR 200kA

Digital Outputs

Configurable Solenoids 3 Max

Voltage 24 VDC

Load Current (max) 1.0 Amps
Digital Inputs

No. Digital Inputs 2 (Configurable)
Voltage 24 VDC

Input Current 5.0 mAmps

Digital Outputs

No. Digital Outputs

3 (Open Sol, Close Sol, Auxiliary)

Voltage

24 VDC

Load Current (max)

250 mAmp

Analogue Inputs

No. Analogue Inputs

2 (Feedback, Command)

Input Type Current / Voltage
Voltage Input Range 1-5.0VDC
Voltage Input Impedance 100 kOhms
Current Input Range 4 -20 mA
Current Input Impedance 300 Ohms
Resolution 1in 3600
Analogue Outputs

Output Type Current / Voltage
Voltage Output Range 4.0-20.0ma/0-3.0VDC
Resolution 1in 3600
Solenoid Ohms

AAA 58 - 65 Ohms
Asco 43 - 54 Ohms

VRG CONTROLS LLC.
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Navigation Wheel Common Tasks

1
2
3
4
5. Reverse Valve Action
6
7
8
9
1

. Local Manual Operation

. Command Signal Calibration

. Feedback Signal Calibration

. Retransmission Signal Calibration

. Edit Fail Modes

. Edit Lockup Mode

. Split Range Configuration
. Determine RCVC Version
0. Zero Out Solenoid Count

#1 Local Manual Operation

1.

Apply 24 VDC Power Supply to RCVC

2. SHORT PUSH Navigation Wheel on RCVC Head

to enter MANUAL mode.

3. Rotate Navigation Wheel AWAY (CW) to increase

valve position percentage (%).

4. Rotate Navigation Wheel to NEUTRAL (center)

position to hold position.

5. Rotate Navigation Wheel Toward (CCW) to

decrease valve position percentage (%).

6. Rotate Navigation Wheel to NEUTRAL (center)

position to hold position.

7. Return Navigation Wheel to Neutral (Center)

Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit Manual mode.
RCVC display Header should read AUTOMATIC.

#2 Command Signal Calibration

1

. Apply 24 VDC Power Supply to RCVC

2. SHORT PUSH Navigation Wheel on RCVC Head

21.01.20

to enter MANUAL mode.

AUTOMATIC 15:19

System Status: Healthy
Actuator Status:  Open Limit

99.8..

100.004%

None
Closed Solenoid O

Actuator
Position

Command

Control Input:

Q Open Solenoid

Navigation Wheel

3. LONG PUSH Navigation Wheel on RCVC Head to
enter MENU mode.

Diagnostics
Data Logging
Settings

4. Select “Application” and SHORT PUSH to enter.

Application

System Data

5. Select “Physcial 1/0” and SHORT PUSH to enter.

Physical 1/0

Digital Inputs
Digital Outputs
Isolated Inputs

Relay Outputs

Analogue Outputs

Internal Sensors

VRG CONTROLS LLC.
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6. Select “Analogue Inputs” and SHORT PUSH to
enter.

Analogue Inputs

Feedback 100.0%
<<Not Linked>> 0

7. Select “Command Signal” and SHORT PUSH to
enter.

Signal ’W

Value W‘ %
Sensorﬂef—

Minimum %

Maximum | 0.0 |%

Signal Type [ Current |

8. Select “Calibration” and SHORT PUSH to enter.

Calibration
Set Calibration
T~
Minimum
Maximum 3291
Minimum 3454
Maximum 3291 |
Save Calibration

9. Select “New Calibration” and SHORT PUSH to
enter.
10. Select “Minimum” and SHORT PUSH to enter.
11. Apply 4.0 mA Command Signal (MIN) and
SHORT PUSH to enter.
12. Select “Maximum” and SHORT PUSH to Enter.

13. Apply 20 mA Command Signal (MAX) and

14.

15.

16.

17.

SHORT PUSH to Enter.

Rotate Navigation Wheel to ESC Position to
reselect NEW CALIBRATION.

Rotate Navigation Wheel Toward (CCW) to
select SAVE CALIBRATION and SHORT PUSH
to enter.

Rotate Navigation Wheel to HOLD ESC Position
until menu stops at MANUAL on DISPLAY
HEADER.

Return Navigation Wheel to Neutral (Center)
Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit MANUAL mode.
RCVC display Header should read AUTOMATIC.

21.01.20

AUTOMATIC

System Status: ealthy

Actuator Status:  Open Limit

Actuator 9 9 8
Position o %
Command 100.00 %

Control Input: 4-20mA Cmd Ctrl

O Open Saolenoid Closed Solenoid O

#3 Feedback Signal Calibration

1.
2.

oo

Apply 24 VDC Power Supply to RCVC
SHORT PUSH Navigation Wheel on RCVC Head
to enter Manual mode.

. LONG PUSH Navigation Wheel on RCVC Head to

enter MENU mode.

. Select “Application” and SHORT PUSH to enter.
. Select “Physical I/0” and SHORT PUSH to enter.
. Select “Analogue Inputs” and SHORT PUSH to

enter.

. Select “Feedback” and SHORT PUSH to enter.
. Select “Calibration” and SHORT PUSH to enter.
. Select “New Calibration” and SHORT PUSH to

enter.

10. Select “Minimum” and SHORT PUSH to enter.
11. Use VMO or other method Stroke control valve

to VALVE OPEN (MIN) position and SHORT

VRG CONTROLS LLC.
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PUSH to enter.

12. Select “Maximum” and SHORT PUSH to enter.

13. Use VMO or other method Stroke control valve
to VALVE CLOSED (MAX) position and SHORT
PUSH to enter.

14. Rotate Navigation Wheel to ESC Position to
reselect NEW CALIBRATION.

15. Rotate Navigation Wheel Toward (CCW) to
select SAVE CALIBRATION and SHORT PUSH
to enter.

16. Rotate Navigation Wheel to HOLD ESC Position
until menu stops at MANUAL on DISPLAY
HEADER.

17. Return Navigation Wheel to Neutral (Center)
Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit MANUAL mode.

RCVC display Header should read AUTOMATIC.

#4 Retransmission Signal Calibration
1. Apply 24 VDC Power Supply to RCVC
2. SHORT PUSH Navigation Wheel on RCVC Head
to enter Manual mode.
3. LONG PUSH Navigation Wheel on RCVC Head to
enter MENU mode.
4. Select “Application” and SHORT PUSH to enter.
5. Select “Physical I/0” and SHORT PUSH to enter.
6. Select “Analogue Outputs” and SHORT PUSH to
enter.
7. Select “Feedback” and SHORT PUSH to enter.
. Select “Calibration” and SHORT PUSH to enter.
9. Select “New Calibration” and SHORT PUSH to
enter.
10. Select “Minimum” and SHORT PUSH to enter.
11. Use Navigation Wheel to set the Value so the
QOutput is equal to 4 ma, then SHORT PUSH to
save value.
12. Select “Maximum” and SHORT PUSH to enter.
13. Use Navigation Wheel to set the Value so the
Output is equal to 20 ma, then SHORT PUSH to
save value.
14. Rotate Navigation Wheel to ESC Position to
reselect NEW CALIBRATION.

©

15. Rotate Navigation Wheel Toward (CCW) to
select SAVE CALIBRATION and SHORT PUSH
to enter.

16. Rotate Navigation Wheel to HOLD ESC Position
until menu stops at MANUAL on DISPLAY
HEADER.

17. Return Navigation Wheel to Neutral (Center)
Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit MANUAL mode.
RCVC display Header should read AUTOMATIC.

#5 Reverse Valve Action

1. Apply 24 VDC Power Supply to RCVC

2. Apply Command Signal to RCVC

3. SHORT PUSH Navigation Wheel on RCVC Head

to enter MANUAL mode.

4. LONG PUSH Navigation Wheel on RCVC Head to

enter MENU mode.

5. Select “Application” and SHORT PUSH to enter.

6. Select “Physical I/0” and SHORT PUSH to enter.

7. Select “Analogue Inputs” and SHORT PUSH to

enter.

8. Select “Command Signal” and SHORT PUSH to

enter.

9. Select “Sensor Range” and SHORT PUSH to

enter.

10. Select “Minimum” and SHORT PUSH to enter.

11. Use Navigation Wheel TOWARD (CCW) to ad
just value to 100% on Minimum. SHORT PUSH
to enter.

12. Select “Maximum” and SHORT PUSH to enter.

13. Use Navigation Wheel AWAY (CW) to adjust
value to 0.0% on Minimum. SHORT PUSH to
enter.

14. Rotate Navigation Wheel to HOLD ESC Position
until menu stops at MANUAL on DISPLAY
HEADER.

15. Return Navigation Wheel to Neutral (Center)
Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit MANUAL mode.
RCVC display Header should read AUTOMATIC.
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#6 Edit Fail Modes

1

. Apply 24 VDC Power Supply to RCVC
2.
3.

Apply Command Signal to RCVC
SHORT PUSH Navigation Wheel on RCVC Head
to enter MANUAL mode.

. LONG PUSH Navigation Wheel on RCVC Head to

enter Menu mode.

. Select “Application” and SHORT PUSH to enter.
. Select “System Data” and SHORT PUSH to enter.
. Select “System Inputs” and SHORT PUSH to

enter.

. For FAIL OPEN Mode:

A. Select Line 8 - “Fault Open” and Click
Radio Button Current Status = “ACTIVE”

B. Select Line 9 - “Fault Close” and Click
Radio Button Current Status = “OFF”

. For FAIL CLOSED Mode:

A. Select Line 8 - “Fault Open” and Click
Radio Button Current Status = “OFF”

B. Select Line 9 - “Fault Close” and Click
Radio Button Current Status = “ACTIVE”

10. For FAIL LAST Mode:

System Outputs

A. Select Line 8 - “Fault Open” and Click
Radio Button Current Status = “OFF”

B. Select Line 9 - “Fault Close” and Click
Radio Button Current Status = “OFF”

Mode Line 8 - Line 9 -
Fault Open | Fault Close
Fail OPEN ACTIVE OFF
Loss 4-20 mA
Fail CLOSED OFF ACTIVE
Loss 4-20 mA
LOCK LAST OFF OFF
Loss 4-20 mA

System Values

System Times

Manual Enable Active

Manual Fast Pos Active

Fault Close

Active
Off
Active
Off
Off

Fault Fast Pos
Lock Up Open
LOck Up Close

1

4.

#7 Edit Lockup Mode

. Apply 24 VDC Power Supply to RCVC
2.
3.

Apply Command Signal to RCVC

SHORT PUSH Navigation Wheel on RCVC Head
to enter MANUAL mode.

LONG PUSH Navigation Wheel on RCVC Head to
enter Menu mode.

. Select “Application” and SHORT PUSH to enter.
. Select “System Data” and SHORT PUSH to enter.
. Select “System Inputs” and SHORT PUSH to

enter.

. For LOCKUP OPEN Mode:

A. Select Line 11 - “Lockup Open” and Click
Radio Button Current Status = “ACTIVE”

B. Select Line 12 - “Lockup Close” and Click
Radio Button Current Status = “OFF”

. For LOCKUP CLOSED Mode:

A. Select Line 11 - “Lockup Open” and Click
Radio Button Current Status = “OFF”

B. Select Line 12 - “Lockup Close” and Click
Radio Button Current Status = “ACTIVE”

Mode Line 11 - Line 12 -
LOCKUP OPEN | LOCKUP CLOSED
LOCKUP OPEN ACTIVE OFF
LOCKUP CLOSED OFF ACTIVE

. Apply 24 VDC Power Supply to RCVC
. Apply Command Signal to RCVC
. SHORT PUSH Navigation Wheel on RCVC Head

to enter MANUAL mode.

. LONG PUSH Navigation Wheel on RCVC Head to

enter MENU mode.

. Select “Application” and SHORT PUSH to enter.
. Select “System Data” and SHORT PUSH to enter.
. Select “System Values” and SHORT PUSH to

enter.

. Select Value 4 Open Limit and SHORT PUSH to

enter.
A. Set Open Limit to desired value when
Lockup needs to engage.

. Select Value 5 Close Limit and SHORT PUSH to

enter.
A. Set Close Limit to desired value when
Lockup needs to engage.
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#8 Split Range Configuration

1. Apply 24 VDC Power Supply to RCVC

2. Apply Command Signal to RCVC

3. SHORT PUSH Navigation Wheel on RCVC Head

to enter Manual mode.

4. LONG PUSH Navigation Wheel on RCVC Head to

enter MENU mode.

5. Select “Application” and SHORT PUSH to enter.

6. Select “Physical I/0” and SHORT PUSH to enter.

7. Select “Analogue Inputs” and SHORT PUSH to

enter.

8. Select “Command Signal” and SHORT PUSH to

enter.

9. Select “Calibration” and SHORT PUSH to enter.

10. Select “New Calibration” and SHORT PUSH to

enter.

11. Select “Minimum” and SHORT PUSH to enter.

12. Apply desired Command Signal value (## mA
Custom Value Here) for VALVE CLOSED
position (MIN) and SHORT PUSH to enter.

13. Select “Maximum” and SHORT PUSH to enter.

14. Apply desired Command Signal value (## mA
Custom Value Here) for VALVE OPEN position
(MAX) and SHORT PUSH to enter.

15. Rotate Navigation Wheel to ESC Position to
reselect NEW CALIBRATION.

16. Rotate Navigation Wheel Toward (CCW) to
select SAVE CALIBRATION and SHORT PUSH
to enter.

17. Rotate Navigation Wheel to HOLD ESC Position
until menu stops at MANUAL on DISPLAY
HEADER.

18. Return Navigation Wheel to Neutral (Center)
Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit MANUAL mode.

RCVC display Header should read AUTOMATIC.

#9 Determine RCVC Version

1. Apply 24 VDC Power Supply to RCVC

2. SHORT PUSH Navigation Wheel on RCVC Head
to enter MANUAL mode.

3. LONG PUSH Navigation Wheel on RCVC Head to
enter MENU mode.

4, Scroll to SETTINGS and SHORT PUSH to select.

5. Scroll to ABOUT and SHORT PUSH to select.

6.

SOFTWARE VERSION will read
A. “V3.13.3” for RCVC 1000
B. “v4.10.2” for RCVC 2000
C. “V4.24.6” for RCVC 3000

#10 Zero Out Solenoid Count

1.
2.

o oA~

o N

10

11

12.

13.

Apply 24 VDC Power Supply to RCVC
SHORT PUSH Navigation Wheel on RCVC Head
to enter MANUAL mode.

. LONG PUSH Navigation Wheel on RCVC Head to

enter MENU mode.

. Select “Application” and SHORT PUSH to enter.
. Select “System Data” and SHORT PUSH to enter.
. Scroll to “Open Sol. Count” and SHORT PUSH to

enter.

. Select “Value” and SHORT PUSH to enter.
. Use the Wheel to decrease the value to Zero and

SHORT PUSH to save.

. Rotate Navigation Wheel to ESC position to exit

OPEN SOL COUNT.

. Select “Close Sol Count” and SHORT PUSH to
enter.

. Select “Value” and SHORT PUSH to enter.

Use the wheel to decrease the value to Zero and

SHORT PUSH to save.

Rotate Navigation Wheel to HOLD ESC Position

until menu stops at MANUAL on DISPLAY

HEADER.

. Return Navigation Wheel to Neutral (Center)
Rotation Position. SHORT PUSH Navigation
Wheel on RCVC Head to exit MANUAL mode.
RCVC display Header should read AUTOMATIC.

System Values

Close Pulse Zone 2.0%
Anti-Surge Zone 10.0%
Min Command 0.0%
Split Command 120.0%
Max Command 100.0%
H 13
Close Sol Count 6

VRG CONTROLS LLC. 9 of 41

NOVEMBER 2021



@VRG CONTROLS RCVC 3000 - Red Circle Valve Controller

Installation, Operation, Maintenance Manual

1 RCVC PROGRAMMING OVERVIEW 4 RCVC PROGRAMMING APPLICATION USER
RCVC Programming Application is a windows based stand- GUIDE
alone piece of software which is used to communicate with a 4.1 Loading Page

RCVC using a wired Modbus communication When first loading RCVC Programming Application the
protocol. following screen will be shown:

Fr'.fe structure Application details
2 INSTALLATION S f—

2.1 System Requirements

To ensure proper functionality of the RCVC programming ap-

plication a standard PC is required with at least the following

system resources:

* 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64)
processor

« 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit)

»  Screen resolution at least 1024 x 768 pixels

2.2 Operating Systems

The RCVC programming application will run on the following

operating systems: {yvra conTroLs ]

« Windows 7 SPI (32 and 64 bit) & /

*  Windows 8.1 (32 and 64 bit) eV Stotis kit Es Curremfﬁrf

*  Windows 10 (32 and 64 bit)

2.3 Hard Disk Space ¢ File Structure - this area contains a list of all controllers

The RCVC programming application requires approximately that have been connected to and can be loaded by dou-

20MB of hard disk space. ble clicking on a file. They are split into three sections:

2.4 Installation *  Online - the project and application of the controller

Extract the installation package to the local disk. Follow the currently connect to

instructions on the setup wizard to complete the installation. « Offline - a list of all projects and applications

(read-only)

3 CONNECTION DETAILS + Standards - a list of saved standard applications

3.1 Modbus Modern which can be re-used on projects to ensure similar

The USB-RS485 modbus modern recommended to be used setups

to communicate between RCVC programming application ¢  Application Details - detail;s of the application currently

and a RCVC is: loaded into the RCVC Programming Application

+ DSD Tech SH-U10 USB to RS485 Converter with e RCVC Status - Indicates whether a controller is
CP2102 chip compatible with Windows 7, 8 and 10 connected and “Online” or not connected and “Offline”

3.2 Modbus Connection to a RCVC e Current File - the program name of the application

To connect from a Modbus modem to a RCVC the positive loaded

terminal of the modem must be connected to MOD+ of the ¢ Main Interactive Area - the area where the application

RCVC terminal, and the negative terminal of the modem is shown and can be interacted with. An application is

must be connected to MOD- of the RCVC terminal. loaded when a file is double-clicked in the file structure

or when a RCVC is connected to
It must be noted that the specified baud rate and Modbus
address in the RCVC must match the set baud rate and
address in RCVC programming application in order for the
communication to be successful.
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4.2 Toolbars

@ VRG ROVC Programeming Application @ VRG RCVC Programming Application

IF_ﬂi‘ Device Modbus Help File .9?."’25.: Modbus  Help

Detect Device
Product Code
Import Standard Connect Dewice

Application tion

| Appica

Exit

application as a standalone text file. This file can then

be loaded as a standard on a different computer or sent

back to engineering for analysis (only enabled when a
file has been loaded)

File/Import Standard - use to import a new standard
application into the Standard folder in the file structure.
File/Exit - use to exit the application (NOTE: if current-
ly connected to a controller, exiting the application will
automatically disconnect from the controller)
Device/Detect Device - use to determine if a controller
can be seen using the Modbus connection. If a control-
ler is found it will indicate on which COM port it was
found, otherwise it will indicate that it is unable to find a
device (only enabled when not currently connected to
a contoller)

4.3 Screens

4.3.1 Home Tab

When RCVC programming application successfully
connects to a controller it downloads the application loaded
on the controller and loads a Home Page showing all
relevant operational data relevant to the application.

All the information on the home page is read-only and is

i Product Code

File/Save Application - use to save the currently loadede

VRG RCVC Programming Application VRG ROVC Programming Application
¥ g Appt

File Device | Modbus | Help File Dewice Modbus | Help
Baud Rate 115200

Address 1

RCVC Manual
About

Offline
Standard:

Offline
Standards

de

|

.
t Code

tio

Device/Connect Device - use to connect to a controller.
It will automatically download the application loaded on
the device and open up the corresponding application
details in the main interactive area (only enabled when
not currently connected to a controller)
Device/Disconnect Device - use to disconnect from
controller (only enabled when connected to a controller)
Modbus/Baud Rate - use to set the baud rate to match
the baud rate of the controller (only enabled when not
connected to a controller)

Modbus/Address - use to set the required Modbus
address to match the controller address (only enabled
when not connected to a controller)

Help/RCVC Manual - use to load this operation manual
Help/About - use to load details for the current RCVC
programming application

Buttons are included on the home page which can be used
to calibrate the controller, and in the case of a diagnostic ap-
plication, operate the actuator and run diagnostic tests. Each
button with ask the user to confirm that the action should be
completed to prevent accidental operation of the controller.

continuously polled so that it reflects the current status of the

controller.
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@vne CONTROLS

ceEn 5T

¢we CONTROLS

st RECORD BINCHEET

cftmare Revaon

Bro Repor 1o POF

N VST R 5D RIP ATO CALRATON MANUAL CALIBRATON
AUN FaT TISTS U MASTER TESTS

4.3.2 Setup Tab

The setup tab contains a number of sub-tabs which contain If viewing an offline application then the settings are
all the settings within the application which can be changed read-only as the offline application shows the status of that

to affect the operation of the controller.

If the controller is online then the settings can be updated

and the change is immediately uploaded to the controller
(Note: a confirmation is required before a change is made to updated as to change what settings are required for that

ensure accidental changes are not made).

controller when it was last connected as a record of each
controller.
If viewing a standard application then settings can be

standard application. Changes are immediately saved when
they are made.

é,vne CONTROLS

en! Nurmber

Prest Feport to PDF
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4.3.3 Diagnostics Tab

EVENT LOGS

The Event Logs tab contains a list of all event logs record-
ed within the controller. It details the event that occurred,
the date it occurred, the duration of the event and the
number of times that the specific event has occurred.

The combo box at the top of the tab can be used to filter
down to specific events and the “from” and “to” dates can
be used to narrow down the time period of events.

The column headers in the table can be clicked to sort
the events in either ascending or descending order to
further interrogate the data.

When connected to a controller a button will be shown
which can be clicked to update the Event Logs to show
the most current status of the controller.

@ VRE ROV Programming Apgication

@vre CONTROLS e

Cffime

Prest Report to POF

DC-PNURC4.25.1 lcadied

4.4 Controller Report

The RCVC programming application contains the ability
to create a report detailing all the settings included in the
controller.

By clicking the “Print Report to PDF” button in the top
right corner when either online or offline a report will be
generated for the loaded application.
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Open Programming Connection to RCVC

1. Ensure that the RCVC App is installed on the
computer and the USB drivers have been
installed. To install USB drivers, connect the USB
to the computer and the drivers will install
automatically if there is an internet connection.

2. Open the RCVC App and ensure there is 24VDC
power to the RCVC.

3. Verify the USB is connected to the computer and
select DEVICE from the menu. Click on detect
device to ensure the RCVC App can
communicate to the RCVC. Once a connection is
established click on Device and select Connect
to device.

4. The program will automatically load the setup
file from the RCVC into the program. A window
will appear asking for a folder name and a file
name. For the folder name it is recommended
to put the station name. For the file name it is
recommended to put the job number, this way it
is easier to keep the files organized.

Eliminate Excessive COM PORTS
on Computer
When attempting to Open Programming Connection to
RCVC using the Setup Application operator may experience
difficulty establishing a COM PORT. It may be necessary to
remove excessive COM PORTS on your Windows™
operating system.
1. Click Windows Button on Computer.
. Type “Device Manager” and Select.
. Click View, Show Hidden Devices.
. Click Ports (COM & LPT)
. Select any “Gray” COM Port and Click red “X” at
top of Window or DELETE.

6. Select uninstall when prompted “Do you want to

uninstall this connection?”

a b WDN

Read and Write Setup File from Controller
1. When connecting to the device the program will
automatically read the setup file. This can be
found under the Online tab on the left side of the
window. You can expand the online tab to see
the folder and file associated with the device.

2. To write a file to the device, right click on the file
name under the online section. Select Load
Standard File and then select the desired file
from the drop-down menu. Click OK to accept
the file and then select Yes to confirm you want to
overwrite the current file.

3. Once complete a message will appear saying
“Write setup file successful-clearing memory.”
Once the memory has been cleared a new
window will pop up letting you know this has
finished. Once complete, select device and
connect to device to reconnect.

Determining Setup file version in the
RCVC App

1. Open RCVC app software

2. Connect to the RCVC Via the USB connection

3. Once connected to the device Assign a project

and file name.

4. In the top information box the Application number
(VRG.4.24.4-2) will display the current setup file version.
VRG.4.24.4-1 for the old version and VRG.4.24.4-2 for the
new version.

Determining Setup file version On the RCVC
Controller

1. Short push the navigation wheel to go into manual mode.
2. Long push the navigation wheel to go into the menu.

3. Scroll down to Settings and short push to select.

4. Scroll to About and short push to select

5. Next to App Revision will be the setup file version num-
ber. VRG.4.24.4-1 for the old version and VRG.4.24.4-2 for
the new version.

New RCVC software setup file upgrade

1. Open RCVC app software

2. Connect to the RCVC Via the USB connection

3. Once connected to the device Assign a project and file
name.

4. Select the setup tab followed by the analog input tab.

5. Copy the calibration values for Feedback, Command and
Retransmission.

VRG CONTROLS LLC. 14 of 41 NOVEMBER 2021



@vne CONTROLS

RCVC 3000 - Red Circle Valve Controller
Installation, Operation, Maintenance Manual

a. You can write the values down or you can put

them directly into a new setup file located in standards ->
VRG Defaults -> BV-LL (Ball Valve Lock Last)

6. Copy over any other changes from the old setup file: Dead
bands, pulse zone, solenoid count, lock up and fail modes.
Ensure that you new setup file matches the old one.

7. Next right click on the file name below the online section
and select load standard file. Select the correct file from the
drop-down menu (BV-LL) and click OK.

8. After the file finished writing to the device. Select device
-> connect to reconnect to the RCVC. The RCVC has now
been updated with the latest version of the setup file.

9. Verify that all calibrations are accurate and run a new
calibration if any need to be changed.

10. Once all settings and calibrations have been re-
stored save the setup file (File -> Save Application)

a. To save the file as a standard file, for future RCVC
applications. Disconnect from the device and find the project/
file under the offline section. Right click on the file and select
save as standard, this will allow you to select this file when
writing to a new device.

Alternative Method for new Setup file

1. Open RCVC app software
2. Connect to the RCVC Via the USB connection
3. Once connected to the device Assign a project and file
name.
4. Right click on file name under the online section and
select load standard file and select the correct file from the
drop-down menu.
5. Once the file has ben loaded, select device -> connect to
device.
6. Once connected run through calibration procedures to
recalibrate the RCVC

a. Auto calibration to calibrate the Balluff (Westlock/
Soldo) to the RCVC

b. Manual calibration -> Analog Input-> Command
signal for 4-20ma command

c. Manual Calibration -> Analog output -> Feedback
for feedback to RTU (Gas Control)

7. Once all settings and calibrations have been restored
save the setup file (File -> Save Application)

a. To save the file as a standard file, for future RCVC
applications. Disconnect from the device and find the project/
file under the offline section. Right click on the file and select
save as standard, this will allow you to select this file when
writing to a new device.

Command Signal Calibration

1. Open programming connection to RCVC and
connect to the device.

2. On the Home Tab, select Manual Calibration
under the calibration section.

3. In the calibration window select Analog Input from
the Type drop-down menu. Select command
Signal from the Signal drop-down menu.

4. Select start calibration, then send a 4ma signal to
the device and select the Set button for the
Minimum. Then send a 20ma signal to the device
and select the Set button for Maximum.

5. Once both values have been set Select the Stop
Calibration button to end calibration. Close out of
the window and select the Setup tab and the
Analog Input tab to verify that the values have
been updated under the COMMAND section.

Feedback Signal Calibration

1. Open programming connection to RCVC and
connect to the device.

2. On the home tab, under the CALIBRATION
section select Auto Calibration.

3. In the Calibration window select Start Auto
Calibration. The valve will automatically move and
save the values for full open and full close.

4. Once the calibration is complete there will be a
Finished message next to the Start Auto
Calibration button.

5. NOTE ** The Auto Calibration can ONLY be used
for the analog input feedback.
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Manual Calibration of Feedback Signal

1

. Open programming connection to RCVC and
connect to the device.

. On the Home Tab, select Manual Calibration
under the calibration section.

. In the calibration window select Analog Input from
the Type drop-down menu. Select Feedback from
the Signal drop-down menu.

. Select start calibration, then move the valve to
the Full Open Position and accept the value in the
Minimum or Maximum depending of the value. If
the value is between 550-750 this is a 4ma signal
and it will be set to MINIMUM. If the value is
between 3200-3700 this is a 20ma signal and
should be set to MAXIMUM. Stroke the Valve to
the full close position and accept the value.

. Once both values have been set Select the Stop
Calibration button to end calibration. Close out of
the window to finish the calibration.

Reverse Valve Action

1.

Open programming connection to RCVC and
connect to the device.

. Select the Setup Tab and under the COMMAND
section select the box next to the Minimum

Edit Fail Modes

1.

2.

Open programming connection to RCVC and
connect to the device.

Click on the Setup Tab then select the Equipment
Tab.

. Under the Fault actions section select the box

next to the Feedback fault Mode.

. In the window that pops up, select the desired

fault mode in the drop-down menu. The fault
modes are OPEN, CLOSE, and STOP (lock last
position). Select OK to accept the current fault
mode.

. Repeat the steps with the Command Fault Mode.
Mode Line 8 - Line 9 -
Fault Open | Fault Close
Fail OPEN ACTIVE OFF
Loss 4-20 mA
Fail CLOSED OFF ACTIVE
Loss 4-20 mA
LOCK LAST OFF OFF
Loss 4-20 mA

Range. A window will appear that will contain the Edit Lockup Mode

current Minimum range valve (100%). Change this
value to 0% and click OK.

. Select the box next to Maximum Range. A window
will appear that will contain the current Maximum
Range (0%). Change this value to 100% and click
OK.

4. This process will need to be repeated in the
RETRANSMISSION section as well.

5. MAKE SURE THAT COMMAND AND RETRANS
MISSION SIGNAL RANGE VALES ARE THE
SAME FOR MIN AND MAX

Mode Sensor Range Sensor Range
MINIMUM MAXIMUM
Open on 0.0% 100.0%
Increasing /
Direct Acting
Close on 100.0% 0.0%
Increasing /
Reverse Acting
Click CLICK CLICK
RECORD MIN | RECORD MAX

1.

Open programming connection to RCVC and
connect to the device.

. Click on the Setup Tab then select the Equipment

Tab.

. Under the Actuator Limits section, select the box

next to the Lock up Open or Lock up Close.

. A window will pop up asking if you would like to

active “Hard seat Open/Close” Click OK to turn
lock up on.

. To turn off simply select the box next to Lock Up

Open/Lock Up Close and select OK when
prompted by the window to turn Lock Up off.
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Setting Open and Close Limits

1

2.

. Open programming connection to RCVC and

connect to the device.

Click on the Setup Tab then select the Equipment

Tab, the Limits will be found in the Actuator Limits

section.

. To change the Open or Close limits, click on the
box next to the limit that needs to be changed. In
the pop-up window change to the desired value
and click OK.

. The Open and Close limit is used to determine
when Lock up will occur. If the valve position is
below the Close limit or above the Open limit Lock
up will engage if it is turned on.

Split Range Configuration

1.

Open programming connection to RCVC and

connect to the device.

. On the Home Tab, select Manual Calibration
under the calibration section.

. In the calibration window select Analog Input from
the Type drop-down menu. Select Command
Signal from the Signal drop-down menu.

. Adjust Command Signal Input to desired value for

the valve CLOSE position and select Record

Minimum or Record Maximum depending on

value.

5. Adjust Command Signal Input to desired value for

the valve OPEN position and select Record
Minimum.

Mode FULL Closed FULL Open
Openon 6.0, 8.0, 10, 12 20 mA
Increasing / mA Typ.
Direct Acting
Close on 18, 16, 14, 12 4.0 mA
Increasing / mA Typ.
Reverse Acting
Click CLICK CLICK
RECORD MIN | RECORD MAX

Dead Band Calibration

1.

2.

4.

Open programming connection to RCVC and
connect to the device.

Click on the Setup Tab then select the Equipment
Tab the dead band will be in the Dead Zone
section.

. In the Dead Zone section select the box next to

the value that needs to be changed. In the pop-up
window change the value to desired value.
a. NOTE: The static Dead Zone should
always be 0.1% greater than the moving
Dead Zone.
It is recommended to change both the open and
close dead bands, so they have the same value.
This can help reduce cycling issues when the
valve is in control.

Pulse Zone Control

1.

Open programming connection to RCVC and
connect to the device.

. Click on the Setup Tab then select the Equipment

Tab, the Opening and Closing Pulse Zone
sections will contain the value and the times

. To change the Pulse zones, click on the box next

to the value and in the pop-up window change to
the new value. Click OK to accept the changes.

. In this section the Pulse Zone times can be

changed as well to modify the duration of the
pulse.
a. Open/Close Max Move: Maximum time
Pulse will be active. VRG Value: 100ms
b. Open/Close Min Move: Minimum time
Pulse will be active. VRG Value: 30ms
c. Open/Close Max Pause: Maximum time
Pulse will be inactive. VRG Value: 150ms
d. Open/Close Min Pause: Minimum time
Pulse will be inactive. VRG Value: 150ms
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Fixed Command Output

1.

2.

Open programming connection to RCVC and
connect to the device.

Click on the Setup Tab then select the Digital 1/0
Tab.

. Under the Digital output 3 section, select the box

in line with Signal and select Command Output

4.

Control to active. Click OK to make this change.
Land the wires to the Digital Input terminal inside
the RCVC. The valve can be controlled using
24VDC. This can only open and close the valve, it
is not recommended for control.

from the drop-down menu in the pop-up window. #18 System Inputs Description

Then click OK to accept

. Click on the Equipment Tab and under the

External Control section the Split Command value
will determine when the RCVC will relinquish
control.

. Ex: For a 5mA signal on open, the increasing

system value entered needs to be 6.2%. This
means when command is at 6.2% or below the
auxiliary digital output will activate. Alternatively,
for closed, the increasing system value entered
for 5mA would be 93.8%.

Enable Anti-Surge Control

1.

Open programming connection to RCVC and
connect to the device.

. Click on the Setup Tab then select the Digital I/O

Tab.

. Under the Digital output 3 section, select the box

in line with Signal and select Anti-Surge Valve
from the drop-down menu in the pop-up window.
Then click OK to accept.

. Click on the Equipment tab and under the

External Control section the Anti-Surge Zone
value will determine when a surge will occur.

NOTE: the value represents the difference in command
signal. IF the value is 10% then a command change greater
than 10% is needed to active the surge.

Remote Command Control

1.

2.

3.

Open programming connection to RCVC and
connect to the device.

Click on the Setup Tab then select the Equipment
Tab, the Remote Command Control can be found
in the Actuator Control section.

Click the box in line with Remote Command
Control, a window will pop-up with a message
asking if you want to set Remote Command

1.

2.

10

1.

12.

13.

14.

15.

16.
17.

4-20ma CMD Ctrl - 4-20ma command control
option

Remote CMD Ctrl - Separate command signal
option (will override 4-20 signal)

. Remote Override - Remote control to override fail

or fault. Open or Close only.

. Remote Open - Set to active to use open

command in Digital Inputs (will override 4-20ma
signal)

. Remote Close - Set to active to use close

command in Digital Inputs (will override 4-20ma
signal)

. Manual Enable - Allows manual mode to be

enabled or disabled (only automatic mode if
disabled)

. Manual Fast Pos - Removes pulse function when

using the manual wheel to control valve.

. Fault Open - Set failure mode to open the valve

on loss of Command or Feedback.

. Fault Close - Set failure mode to open the valve

on loss of Command or Feedback.

. Fault Fast Pos - Disables pulse setting when a
failure occurs.

Lock Up Open - Enables lock up on the open
side of the valve.

Lock Up Close - Enables lock up on the close
side of the valve.

Lock Up Fast Pos - Disables Pulse setting when
Lock Up engages.

Fail on Feedback Fault - Enters failure mode if a
Feedback fault occurs.

Fail on CMD Fault - Enter failure mdoe if a
Command Fault occurs.

Auto Mode Switch - Switches to Automatic Mode.
Man Mode Timer - Enables a time limit for
Manual mode, switches back to Auto mode after
time ends.
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RCVC Troubleshooting

Problem Resolution

Actuator Position (feedback) scaling I/O card is damaged and needs to be
problem, showing 60-120% or 0-70% even | replaced.

after calibration.
Healthy System status but will not show Check system inputs to verify 4-20ma

change in command signal control is active. Reload setup file to reset
system.

Command signal scaling issue. Ends are The ISO card is bad and needs to be

correct at 4ma and 20ma, show 0% and replaced. Board on the right side.

100% but 8ma, 12ma, 16ma are not scaled

correctly

Feedback to RTU (Retransmission) not Make sure the Feedback loop is powered

showing any signal at RTU by the RTU. RCVC is a dry loop needs

external power.

RCVC not triggering the solenoids on open | Move valve to 50% for testing. Test
or close signal, Auto/Manual solenoids in Manual mode to verify if
solenoids are working or not.

1. Solenoid may be bad, test using
external 24VDC. If solenoid does
not trigger replace solenoid.

2. Display board may be bad. Connect
multimeter to SV1 or SV2 and
trigger solenoid when in manual.
Verify 24VDC signal when solenoid
should be active. If no signal,
replace display board.

Valve not moving when full open or close | Check sensor range in analog input for
but will move when not at full open or Feedback to check it matches values from
close position. transmitter. (VRG default 4ma = 100%
20ma = 0%) recalibrate or change sensor
range to fix. Test at full open/close to

verify.
Solenoid cycling issue. Valve will not reach | Go into system values and adjust
set point and solenoids continue to Deadband. Increase to static to 1.0% and
trigger. moving to 0.9%. Test to verify functionality

and adjust as needed. If Deadband
exceeds 1.5% and issue persists then
adjust pulse zone to 3% or 4% and retest.
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@VRG CONTROLS RCVC 3000 - Red Circle Valve Controller

Installation, Operation, Maintenance Manual

Balluff BTL7 Linear Transducer Programming Guide

IFM agend: ) FD mod o

@ LED groar

ga—'gl ED 1 e LED 2 Nashit ny g g it
@ LED el el

Button 1: BLUE
Button 2: GRAY

Fig. 7-1: Calibration device in place

1. Attach Calibration device to connection side of transducer.
2. Make sure magnet is within measuring range

Two green LED lights indicates that the magnet is within the current measuring range.
* Two Red LED lights indicate that the magnet is not in current measuring range.

NOTICE!

Interference in function

Teach-in while the system is rurning may result in
malfunctions.
» Stoo the system before performing teach-in.

LED display Displayed values [example)

LED1 LEDZ2 AtOto 10V At4to20mA

Initial situation:

- Iranscucer with magnet within measuring range F——— @ @ [ 539V [|9i5mA |
Activate teach-in AR
e Prass @ for at least 4 s, 4 @ | 539v || 915mA |

* Initiate teach mode by holding the Blue button for a minimum of 4 seconds. When you see two flashing green
LED lights this will indicate that you are in teach mode.
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@VRG CONTROLS RCVC 3000 - Red Circle Valve Controller

Set null point
> Hring magnet to the new null point, o—— | 1oav || es2ma |

» Mress ) for ot least 2 s ~2s5 O

poov || 400ma |

g
= Thea new null point is sat once the button is 6
redeased.

= Toset a new null point, press the blue button for at least two seconds or until you see the LED flash red to
indicate completion.

T
Set end point Ei— 8
B Rring magnit to tha new snd point

* Fress @ for al lesst 2 s, 28 2

983V || 1913 ma |

64— =
= The new end point iz set once the button is 1000V | | 20,00 ma, |

raleased.

= Toset anew null point, press the gray button for at least two seconds or until you see the LED flash red to
indicate completion.

Invert curves
» Simultanecusly press @ and (D for at least 4 s, until 0D+2

o O
both LEDs are illuminated in red.
=>d5 . .

= The curves of both outputs are iIMeerkted once the
buttons are released,

# Toinvert the curve [change between rising and falling) hold the blue and gray buttons for 4 seconds or until
the lights flash red to indicate that the change has been made.

End teach-in
B Eriefly press i and @ simultanecusly (< 1 s). <1s 0-+2) ® O

= The curment position value is displayed once the
buttons are released,

ﬂ Ary of the individual steps for settings can be
selected. The teach-in process can be ended al

any time.

* Toend teach mode, briefly press the blue and gray buttons simultaneously. Two solid green LED lights
indicate teach mode has ended.
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1 0 Reset all values with the calibration device (reset)

NOTICE!

Interference in function

Resetting all values while the system is running may
result in malfunctions.

» Stop the system before performing the reset.

The reset function can be used to restore all the settings to
the factory settings. For a reset the magnet may also be
located outside the measunng range.

LED display
LED1 LED2

Activate reset

* Simultanecusty press @ and @ for at least 4 s, ~ds Ez)
» Helease buttons.

= Reset is activated.

o»

@

Reset 2 ]
» Press @ and @ for at least 4 =, =45 @ 6 6

» Release buttons.
= All values are reset.
= Current position value is displayed.
= Reset iz deactivated.

Abort reset

ﬂ Resetting can be aborted without any changes
being saved after the Activate reset step.

» Brefly press @ and @ simultanecusly (< 1 ). <15 @+@) o O
> Release buttons.
= Current position value is displayed.

LED legendt  {_JLED nat an

@ LED green

F 3

%
éLED Nlashing green-red a 6|_E|:| 1 and LED 2 fashing green-red sirmdtan eousky
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Figure 16: RCVC 2D Drawings for Single and Double Acting Applications
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While this information is presented in good faith and believed to be accurate, VRG Controls LLC. does not guarantee
satisfactory results from reliance upon such information. Nothing contained herein is to be construed as a warranty or
guarantee, expressed or implied, regarding the performance merchantability, fitness or any other matter with respect to
the products, nor as a recommendation to use any product of process in conflict with any patent. VRG Controls LLC.
reserves the right, without notice, to alter or improve the designs or specifications of the products described herein.

ADDRESS: VRG Controls, LLC.

Lake Zurich, IL 60047, USA )

TOLL FREE: (800) 844-FLOW-VRG VRG CO NTR O |_S
E-MAIL: sales@vrgcontrols.com . )

WEBSITE: vrgcontrols.com

VRG CONTROLS LLC. 41 of 41 NOVEMBER 2021




